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1 Introduction

Grant applications for the MEDIA Programme for the 2012 budgetary year must be made using the
eForm, and this online submission is considered to be the master copy. However, in order to provide
safeguards for both applicants and for the Agency, 1 paper copy must also be sent by post.

Please note: the application package for the paper copy has additional annexes (that are not part of the
online submission). Please ensure that your paper copy includes all requested documents. For details
of these, please consult the MEDIA Programme Website.

The purpose of this document is to provide guidance on the technical aspects of completing and
submitting the eForm. It does not replace the Guidelines which must be read and consulted by
applicants for all guidance on the content of the application form, the application procedure and the
rules that must be respected. These can be found via the following webpage:

http://ec.europa.eu/culture/media/programme/distrib/schemes/select/index_en.htm

Please note that the terms 'eForm’, 'form’, ‘application form' and 'online application form' are used
interchangeably throughout this guide.

You are strongly advised not to leave the preparation and submission of your application form until
the last days before the deadline for applications

Please read all of this User Guide before beginning your application

2 Technical Requirements & Considerations

The application form is an interactive PDF form that requires Adobe Reader software software to be
installed on your computer for you to be able to complete and submit it.

The retrieval and submission of the form are ‘online’ activities but completion of the form and its
validation are ‘offline” activities. This is explained in more detail in the process overview below.

Adobe Reader

The minimum version i.e. lowest version of Adobe Reader that you must have installed on your
computer is version 8.1.5. You may also use a higher version than this e.g. 9.0, 9.1 etc. If you have a
lower version than 8.1.5, you will not be able to complete and submit the eForm.

Follow the link below to be directed to Adobe's website to download the software free of charge or to
upgrade your existing copy of the software. If you do not have administrator rights on your computer
this activity may require the intervention of your IT department. You will need to specify your
operating system before the download can commence.

http://get.adobe.com/reader/otherversions/

If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise
be 8.1.5 or higher.

The screenshots in this User Guide are based on version 8.1.6 of Adobe Reader.
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You can check the system requirements for Adobe Reader — i.e. the minimum required specification of
your computer — through the following link:

http://www.adobe.com/uk/products/reader/systemreqgs/

Security settings in some versions of Adobe Reader and Adobe Acrobat

If you are using a version of Adobe Reader or Adobe Acrobat that incorporates Enhanced Security, it
is possible that the enhanced security settings will block the submission of your eForm. The involved
versions of Adobe Reader and Adobe Acrobat are:

e 8.2 or any higher version 8 than this (including any sub-versions e.g. 8.2.1, 8.2.2 etc);

e 9.3 or any higher version 9 than this (and including any sub-versions e.g. 9.3.1, 9.4.2 etc;

e any version X (including any sub-versions e.g. 10.0.1)

The disabling of the Enhanced Security is performed from the following Adobe Reader menu path:
Edit > Preferences > Security (Enhanced)

Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed

you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),

please refer to the relevant 'Known Issue' on the following webpage:

http://eacea.ec.europa.eu/eforms/index_en.phptissues

Here you will also find instructions on how to leave Enhanced Security enabled but identify your
eForm as a trusted item (stored in a “privileged location’) so that its submission is not blocked.

Internet Connection & Browser software

You will require an internet connection and standard browser software to retrieve and submit the
online application form.

Test eForm
A test eForm is available on the EACEA eForm home page:

http://eacea.ec.europa.eu/eforms/index_en.php

The form contains a small number of questions and functions. It has been designed to help applicants
understand how the main fields in the eForm work and also to ensure that their own software and
internet connection allow an application form to be submitted. It is NOT mandatory to use this form; it
is provided as a help tool for applicants who are using electronic submission for the first time.

Advice for Macintosh Users
The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat
products. It is not possible to open and work with the eForm using the Mac Preview viewer.

Please therefore ensure that if your default viewer is set as Mac Preview, you nonetheless open the
eForm with one of the Adobe products mentioned above. This advice applies to both the download of
the form — if you try to open it before downloading — and to the opening of the form for its general
completion and submission. For more detailed advice, please visit the ‘Known Issues’ section of the
EACEA eForm home page:

http://eacea.ec.europa.eu/eforms/index_en.phptissues
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3 The Online Application Process — Overview

()  You download the eForm from the agency website, saving it to your own computer or local
network drive. Do not try to fill in the form directly on the website. The form can only be
filled in once you have saved it to your local computing environment.

(i) You complete the eForm on your own computer. You do not need to be connected to the
internet for this and no connection to the EACEA website or any Commission server is
required. Completion of the form includes the attachment of the annexes.

(iii)  You validate the form (on your own computer) to ensure that it is ready for submission.

(iv)  You connect to the internet and press the submit button to submit your form. You do not need
to be connected to the EACEA website or to any particular webpage — this connection to the
Agency server happens automatically. (The submission process includes a mandatory save
both before and after the submission. These save operations are instigated by the form itself.
This is explained in detail in section 8.)

(v)  If the submission is successful, a submission number will be automatically generated and
added to your form.

(vi)  You print your form.

(vii)  Anemail acknowledging receipt of your form is automatically sent to the email address that
you entered for the contact person of your Organisation (Part A.3).

4 Working with the eForm

4.1 Download the eForm from EACEA

A link to a read-only copy of the form can be found on the on the EACEA eForm home page:
http://eacea.ec.europa.eu/eforms/index_en.php

Save the form to your local computer respecting the following filename convention:

dis_sel_company ISO country code_company name_AppForm.pdf
e.g.: dis_sel BE_Filmcompany_AppForm.pdf

You can now open, save, close, print etc the file in the same way you would any other document you
had saved or created on your own computer.

4.2 Adobe Acrobat Reader — a brief introduction to some key features of the pdf form

Activate the Activate _
Highlight Fields Page Thumbnails
facility (see below)
VERY
USEFUL!

e Attach facility
DO NOT USE!

The eForm has its
own attach facility

Adobe Help for
common features

Navigation panel,
on the left-hand
side of the screen
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Toolbar

From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not
already displayed. There are also various display and navigation options that you can add.

—
IEiIe Edit  Wiew Qn:ucument( L:n:uls)ﬂindl:uw Help

I amrrEay = Y -

More Tools

[]5 ] Copy
File Toolbar
[ open
=l Print
[ save
[ & attach aFile... *
] nSearch
[ 1 E=EEmail

Gl 5kart Meeting. .. §
Find Toolbar

Measuring Toolbar *

Object Data Toolbar

Page Display Toolbar

TI_HI Scroling Pages

l‘_:_'| Cne Full Page —
|:| ﬁ' Single Page Continuous
1| |single Page

[ UL mwa-up

¥ ﬁHTWD-Up Continuous

¥ @Full Screen Mode

¥ ﬂRDtate Counterclockwise
[ [ ratate Clockwise

— a1 .

< |

Toolbar

Customise
toolbar
selection menu
(partial view)

KOOE

|
54

Explained here are some of the commonly used display and navigation options:

Fit form to width
of screen and
scroll across
page boundaries

it Tools wWindow Help

RN JEERT N S = =

Turn on ‘Page

View’ —
Move Zoom In Zoom Out 1 whole page
forward 1 (reduce (enlarge displayed ata
page image size) image size) time
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Page Thumbnails

If you activate the Page Thumbnails option, a new panel is opened up on the left-hand side of the
screen. It contains miniature previews (‘thumbnails’) of each page:

f-N=T R BRI - - | GEE

=

] EAGA
e Use the
thumbnails to
= Part A: Identification ol jump to different
! in the project. areas of the form.

= o A frame outlined
A — A.1 Organisation in red indicates
Full name of the organisation Where yOU are in

5 Full name of the organisation in Latin the document.
characters (if applicable)

Red frame Acronym e Right click on the
indicating panel to access
your VAT number *: options to enlarge
location

Reaistrati N or reduce the
egistration number *: R
3 thumbnails.

Registered address:

Street*:

Zoom in/ Zoom out

To rapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse:

Scroll up to zoom out, increasing the size of the image
Scroll down to zoom in, decreasing the size of the image

4.3 eForm completion

The eForm is an interactive PDF form that contains form fields that are either selected from a
restricted list or filled in using free text:

Click inside a text field to enter data.

Click to select options from e.g. dropdown lists and radio buttons.

Press Tab to move forward one field or Shift+Tab to move backward one field.
Point and click with the mouse to select a specific field.

Please note that when you use the tab facility, the tab doesn’t just ‘land’ on modifiable form fields — it
also lands on the various buttons and protected fields that appear in the form. In order to reach the next
field that you wish to complete, simply continue tabbing until the cursor point arrives in the desired
field.
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4.4  Mandatory, optional and calculated fields

Field Type Characteristics Examples
Field label is
. Telephone 1 *:
Mandatory | accompanied by an
asterisk *
. . . Telephone 2:
Optional Field label has no asterisk “lepnone

Production Designer I

Totad ‘

Calculated Field contains diagonal
automatically | grey lines.

Number of towns forecast for first release:

How to highlight mandatory fields

Click on the purple button in the navigation panel and this will activate the Document message
bar which incorporates the Highlight Fields feature.

Click on the Highlight Fields button and all
mandatory and optional fields will gain
highlighting that makes them easier to identify
(and easier to differentiate from one another).

Mandatory fields — red border and a light blue background
Optional fields — light blue background (and a black border when you hover the cursor over them).

Unhighlighted fields ‘ Highlighted fields

Region * :

Country *: Region *: Country *:

] A
Internet address: Internet address:
Telephone 1*: Telephone 2 Telephone 1*: Telephone 2

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and it
will not be possible to submit your form.

Once you have activated the highlighting you can click the purple button again to remove the
Document message bar (and maximise the display of your form).
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4.5 Saving your form

To save your form, click on the Save button on the toolbar or select Save from the File menu or press
CTRL and S.

File Edit Wiew Document Tools indow Help
P

,;ﬁ]("])&sgv @ B (x| 6 ® [105% |- Bl [

Please ensure that you save your form on a regular basis. If you encounter a problem in your local
computing environment and your form or your computer crashes, the Adobe Reader auto-recovery
function will only restore your form to the point of the most recent save.

4.6  Entering Dates and Numbers

Please respect the following rules when entering dates and numbers on the form:

Rule Example

Only whole numbers are accepted. Do not use
any separators such as commas or dots.

Numbers The exception to this is the % in the co- 50000 not 50,000
production field where decimal places are
permitted.

01/10/2011 for 1st October

Dates All date fields are in the format dd/mm/yyyy. 2011

No rules - this is a free text field but please -

Telephone numbers | ide the country code.

4.7  Formatting

If you enter formatted content into the form e.g. through copy-and-paste from other document sources,
the eForm will strip off the formatting and plain text only will be pasted into the form.

Please do not copy bullet points into your form. The formatting of some bullets can trigger the
requirement to download add-ons to your Adobe Reader software (so that it can handle those bullets).
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4.8 Character Limits

The free text fields in the eForm have character limits that restrict the amount of text you can enter.
These limits include both characters AND spaces. If you try to enter more characters than the limit
allows the form will simply restrict the text to the predefined limit. Many word processing packages
have a 'count’ tool that may help you respect the limits. For other fields, please consult the following
table:

Part Field Character Limit

Full name of the organisation 192

Full name of the organisation in Latin characters 192

Acronym 64

VAT number 64

Registration number 64

Street 64

Post code 12

Town 64

A Internet address 192
Street 64

Post code 12

Town 64

First name 64

Family name 64

Role in the organisation 64

Email 128

Title of the film 256

Director name 192

Script writer 192

Actor 1 192

Cl& _C'2'1 Actor 2 192
(Coordinator Actor 3 197

selected)

Composer 192

Photo director 192

Production Designer 192

Editor 192

Sound 192

Format 64

Shooting language 64

Name of the company 192

C.22,C.23 [aAddress 64
& C'.2'4 Post code 12
(Coordinator Town )

selected)

Fax 64

Phone 64

Email 128

Distributor 192

C.1&C.2 [Title of the action 256
(Dsljlter é{)e%t)or Target audience 1024
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5 Guidance for specific Parts of the form

5.1 Cover Page

Important!
Information concerning the deadlines for submission

Please be aware of the following constraints:
e  Applications may only be submitted for the next scheduled deadline — the online system

blocks the submission of applications that are for a deadline that is not the next scheduled
deadline.

e  Once a deadline has passed, there is a gap in time before the online submission system is
re-opened for the next scheduled deadline. Here are the details of when the online
submission system is opened for each deadline:

0 Deadline 1/12/2011 Submission was opened when the eForm was published,;
0 Deadline 30/03/2012 Submission open from 15/01/2012;
0 Deadline 29/06/2012 Submission open from 02/05/2012.

o |f you attempt the submission having selected a deadline that is not the next scheduled
deadline OR when the online submission system is closed, the submission of your form
will be blocked and it will not take place. Nevertheless, it will still be possible for you to
submit that same form once the submission has been opened for the deadline you are
interested in. Be aware, however, that the submission process will have locked your form
so you will no longer be able to modify its content or change the attachments.

e Itisnot possible to submit an application for a deadline that has already passed. The
online system blocks such submission attempts.

e If you have attempted the submission for a deadline that has passed, it will not be
possible to correct the deadline value (and resubmit) because the form will be locked.
You would therefore be obliged to start your application again with a new form!

5.2 Part A - Identification of the applicant and other organisations participating in the project
e The field “Internet address’ in Part A.1 relates to the organisation’s website address.

e Select 'Coordinator' or 'Distributor' before completing the rest of the form. The fields that
appear in the rest of the form vary according to the choice you have made.

Applying as *
(" Coordinator
(" Distributor

The following parts of the form will adapt based on this application role.

NB Once you have selected 'Coordinator' or 'Distributor’, if you subsequently change your
selection this will automatically modify the rest of the form!
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5.3 Part C — Action ldentification
APPLYING AS COORDINATOR

C.2.1 Cast & Crew

e Include first and last name;

e TIP: when completing a field that requires a country value e.g. nationality, country of
residence, shooting location etc., instead of deploying the dropdown menu, enter the initial
letter of the country into the field. This will take you to the first country in the list that begins
with that letter. Press the same letter again to move to the next country that begins with that
same letter. The up and down arrow keys on the keyboard can also be used to navigate the list
without deploying the dropdown menu.

C.2.2 Information regarding the film

o Enter the 'Length (in minutes)' in rounded up minutes (e.g.: '91" for a film lasting 90 minutes
and 10 seconds;
o Please keep the “Format” field concise and as short as possible.

C.2.3 Financing plan of the film

o Enter the full legal company name of the Producer and Co-producers.

C.2.4 Distributors participating in the grouping

Enter the full legal company name of the distributors;

Forecast dates may be approximations;

Enter the amount requested in whole numbers of Euros only — do not use decimal places;
Total fields are calculated automatically and cannot be entered manually.

APPLYING AS DISTRIBUTOR

C.2 Description of the Action

o Enter the 'Predicted number of weeks in exhibition' as a whole number of weeks without any
fractions of a week e.g. enter '52' to represent 1 year.

o Enter the 'Distribution territory' by entering country names. Separate the names by commas if
more than one territory is concerned.
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6 Attaching Documents to your eForm

Depending on whether you are applying as a Coordinator or Distributor the following mandatory
annexes, which are a formal part of your grant application, must be attached to your eForm:

Distributor:

e Declaration of Honour;
e Budget.

Coordinator:
e Declaration of Honour.

Please respect the following filenames and formats for your attachments:

Annex Required Filename Required Format
Declaration dis_sel _ISO country code_company name_DecHon .pdf, .doc, .docx,
of Honour .Jpg or .jpeg

Budget dis_sel_ISO country code_company name_Bud xls or .xlsx

Attachment size limitation

There is a limit to the total (combined) size of your attachments. This is 5SMB. If you receive a
message advising you that the total size of documents exceeds the maximum allowed, please reduce
the size of the image-based document e.g. by reducing its resolution.

Example filename
For a company called Bestco based in Belgium, the budget annex would be named:

dis_sel BE Bestco Bud

(This example filename does not include the extension details — .xIs or .xIsx)
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To carry out the attach function, click on the relevant Attach a document button and a window will
pop up enabling you to browse, locate and select the file you wish to attach:

Attachments

Declaration of Honour. PDF, JPG or MS-Word document only (PDF, DOC, DOCX, JPG, JPEG).

Attach a document

Budget. Excel docume

Attach a document

XLS, XLSX).

\(arning: JayaScript Window - Select a data file to import

Look in: |lﬂ Documents for grant application v| - T = [
Fecent

Desktop

7 sample Declaration of Horour

: L
Click on the “‘Open’ button to My Docuerts
attach the selected file to your s
application. "

ormputer

File name: | v ‘ [ Open 1

My Metwork | Files of tupe: [AllFiles %) V] [ cancel |

Once a file has been successfully attached, the filename is displayed and the Attach a document
button is replaced by a Delete this document button and a View this document button:

Attachments

Declaration of Honour. PDF, JPG or MS-Word document only (PDF, DOC, DOCX, JPG, JPEG).

[Delete this documentI View this document } Document: Sample Declaration of Honour.pdf

Please note the following:

Your ability to view a document that you have attached is subject to the security settings on
your computer. Please consult your IT department if you need to change the security settings
in order to view an attached document. This phenomenon does not affect the document itself
which retains its content and integrity.

Once your form has been submitted it is no longer possible to view the attached documents.
This is because the form and its content are ‘locked’ when you confirm that you wish to
perform the submission (see also section 8 of this guide).
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7 Validation of your eForm
The Validate Form button appears at the top right of every page of the form.

EAG:A

Education, Fudlgloia] & Caliore Clicking the button validates the whole
Exceutive Agency

form, not just the page you are on.
Validate form

(It is recommended that you do not validate your form until you have finished completing it as
validation slightly alters the look of the form. It also uses up computer memory, so it is best not to
validate if you know that you still have a significant number of mandatory fields to complete.)

When you are ready, click on the button and various checks will be automatically performed to
ascertain whether your form is ready for submission. For example, the validation will verify that all
mandatory fields have been completed and that all the mandatory attachments are present.

If there are any errors present, the total number of them will be listed on the last page of your form. If
there are any budget or attachment errors these will be itemised separately in the same list:

Submit this form

Submission

000000000 number

Number of mandatory field(s) not filled in: 225

The declaration of honour has not been attached.

The budget tables have not been attached.

The errors themselves will be highlighted in pink. In the example that follows the mandatory fields
VAT number and Registration number have not been completed:

When you validate, an additional button — the Go to Next Error button — appears next to the Validate

form button.
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Use this button to jump from error to error in your form. The function starts with the error nearest the
top of the form i.e. nearest to Page 1 and descends the form moving to the next error with each click.

Please note the following:

When you fix the errors that are highlighted, the Errors list is not dynamically updated. It is
only updated i.e. refreshed when you perform another validation.

The Go to Next Error function works best when you fix errors one by one, following the top-
to-bottom sequence used by the Go to Next Error button. If you fix errors out of sequence
e.g. fix an error further down the form, the Go to Next Error function will still follow the
original sequence of errors reported by the validation.

If you have fixed errors out of sequence, you are recommended to perform a fresh validation
so that the errors you have fixed are removed from the sequence (and you would then start
again from the error nearest the top of the form).

If you prefer, you can simply do a visual search for the pink errors in your form. If you do
this, it is recommended that you first turn off the highlighting for mandatory fields (see
Section 4.4). You may find the thumbnail view a useful aid to quickly detecting the pink
highlighted fields (see Section 4.2).

Whichever method you use, fix the errors that are present and validate your form again. If all errors
have been resolved you will see the following pop-up message:

Warning: JavaScript Window -

\]::) The Form is valid For submission!

Until your form validates successfully the Submit button is disabled and it will not be possible to
submit your form. The Submit button turns from grey to green when validation has been carried out
successfully.
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8 Submission of your eForm

On the final page of the form is the Submit this form button. Once your form has been successfully
validated the button is enabled (as confirmed by its green colour). Click on this button to launch the
submission.

Submit this form

The following message will appear:

Warning: JavaScript Window - Submission confirmation

Yol are about o submit your application, This process can take some time,
“‘-—"{J Do you wank to continue?

= =)

If for any reason you do not want to continue, you may click No and carry out the submission at a later
time. The submission process will end. Once you click Yes your form will be locked and it will no
longer be possible to modify its content, change the attachments or view the attachments.

8.1 The mandatory save BEFORE submission

If you click Yes, the next step of the submission process is a mandatory save. The following message
appears:

Warning: JavaScript Window, - Save Before Submission

Please keep the SAME FILEMAME For wour Farm,

’T You must now save vour Form before the submission process starts,
Do not change the filename during the save,

When you click OK, the form triggers a Save As operation. You will see the classic Save As window as
appears in the screenshot which follows.

(Please note: this screenshot is simply an example of the Save As window. The window that you see,
will reflect the filename and directory name that you have been using.)
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Save jn: |@M_I,J eFarm application Vl € ? Sl Fr o

E dis_sel_BE_Filmn Company_appForm. pdf

Al

My Recent
Documents
?\[‘: N
Desktop 4]
Example screenshot
-—-j Type: Adobe Acrobat Document

My Documents File Size: 1585 KB
Modified; 18/02/2010 18:24

=

=

:
@r)
-

=%

@

File hare: n:Ii:z: zel BE_Film Company &ppForm. pdf V| [ Save ]

MyNetwork  Saveastype | Adobe POF Files [* pdi] v| | Cancel |

You must now perform the Save As by clicking on the Save button.

Very Important!

You must NOT change the filename of your eForm.
You must keep the same filename that the file had when you began the submission operation!

Click Yes when you are asked if you want to replace the existing file:

LMy FilesiMy eForm applicationidis_sel_BE_Film Cormpany_appFarm, pdf

\-‘f) The file already exists,

Replace existing File?

8.2  Submission

Depending upon your security settings, the following pop-up window may now appear:
Security Warning [Z|

The document is trying ko connect ko
! http:/feacea.ec.europa. euWSEMLR eceiver Ax2 T fservices WSEMLR eceiver fwsd
I

If wou trusk the site, choose Allow, IF wou do nok trust the sike, choose Block,

[ Remember my action For this sike:

Help l [ Allo ] [ Bilock.
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If the window appears, click on the Allow button in order to proceed with the submission.

When the submission is complete you will see a pop-up message similar to the one that follows:

Warning: JavaScript Window - Successful Submission Message

9£23585-MED-1-2012-1-BE-MEDIA-DISSEL

\id) Details of the result: Success, Your Project Mumber is:
Please, 3aVE and PRINT the application form before closing it,

Click ‘OK".
8.3 The mandatory save AFTER submission

When you click OK, the form triggers another Save As operation. This is so that you cannot
mistakenly close the form without saving (and so lose the submission number).

Once again you will see the classic Save As window appear:

Save jh: | 1) My eForm application Vl €} G
Y ‘; dis_sel_BE_Filmn Company_appForm. pdf
My Recent
Documents
=
I_ ma..
“hisk
Desktop
N Example screenshot
_._j Type: Adobe Acrobat Document

My Documents File Size: 1585 KB
Modified; 18/02/2010 18:24

=
=
[yl FY
@r)
-
=%
@

File hare: n:Ii:z: zel BE_Film Company &ppForm. pdf V| [ Save ]

MyNetwork  Saveastype | Adobe POF Files [* pdi] v| | Cancel |

You must now perform the Save As by clicking on the Save button.

Very Important!

You must NOT change the filename of your eForm.
You must keep the same filename that the file had when you began the submission operation!
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Click Yes when you are asked if you want to replace the existing file:

Save As |E|
9P LMy FilesiMy eForm applicationidis_sel_BE_Film Cormpany_appFarm, pdf
\““:I'/ The file already exists,
Replace existing File?

When you click “Yes’, the submission number is automatically added to the ‘Submission number’
box:

Submission

522385-MED-1-2012-1-BE-MEDIA-DISSEL
number

It is also inserted into the footer of your form.
The form has also been saved and this save included the submission number.

Your submitted form is now ‘locked’. That is to say, it has been converted to a read-only document:
changes cannot be made to it and it cannot be re-submitted.

As part of the submission process, an email message acknowledging receipt of your eForm is
automatically sent to the email address you entered for the contact person of the Applicant
Organisation (Part A.3).

As instructed by the earlier pop-up message, you should now print the form before closing it.

Please consult the Guidelines for details of how to submit the paper version of your eForm.

9 Printing your eForm

The eForm can be printed using Adobe Reader’s standard menu-driven print function. The Print
button is found on the tool bar, or the Print menu can be selected from the File menu.

wit View  Docurment
G-I

10 How to obtain technical assistance — EACEA Technical HelpDesk

If this User Guide does not provide answers to all of the technical questions or problems you
encounter in completing the application form, a telephone and email HelpDesk service is available to
assist you further:

EACEA Technical HelpDesk: +32 229 90705
eacea-helpdesk@ec.europa.eu
Monday to Thursday 08:30 to 17:30 (CET/CEST)
Fridays 08:30 to 17:00 (CET/CEST)
Excluding public holidays
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Should you experience what you believe to be a significant technical issue with the eForm it will be
worth checking the website of the programme you are applying for since, in the event of a general
technical problem, an update bulletin would be posted.

You may also visit the Agency’s dedicated eForm webpage which contains the latest versions of all
published forms along with a Test eForm and other items of information:

http://eacea.ec.europa.eu/eforms/index en.php

Non-technical assistance

If you require assistance with a query or problem that is not technical in nature, please do not contact
the EACEA Technical Helpdesk. This Helpdesk team are only authorised and trained to help
applicants who are encountering technical problems.

Please refer instead to the Selective support webpage of the programme/action that you are applying
for. On this webpage you will find details of how to obtain non-technical assistance e.g. assistance
with questions on:

e the content of the eForm;
o the application process including instructions for providing the backup copy;
o the rules of the programme / Call that you are applying for.

Generally speaking, the Selective support webpage will include the mailbox address of the programme
team that is responsible for the programme/action that you are applying for. The page will also contain
documentation that may already provide an answer to your non-technical question e.g. a Programme
Guide or Guidelines document or a link to an in-country Helpdesk / MEDIA Desk which can help you.
If you cannot find the answer to your question, please contact the mailbox of the programme team
cited on the Selective support webpage.

The following table provides some examples of technical and non-technical questions.

Non-technical Questions
(handled by the programme team or by an in-
country Helpdesk)

Technical Questions
(handled by the EACEA Technical Helpdesk)

What is required to be entered for the field

| can’t download the form. Registration number?

A dropdown list isn’t working. Why isn’t country A in the dropdown list?

| can’t attach my budget form (or

other annexe/attachment). I need help with completing my budget form.

How does the synchronisation of fields work? Why is this field mandatory?

Our project has more than one coordinator.
What should I do?

What is the minimum / maximum number of
partners that is allowed?

I can’t delete a table row that | have entered.

What documents are required for the paper

My form freezes/crashes. backup and where do | send it?

My form is working slowly. I need more characters for my answer!

My form won’t validate. What do you mean by the term ‘acronym’?

Where are the templates for the attachments and

My form won’t submit. additional documents?

What should | enter in the form for my project start

I think there is a bug in the form. and end dates?
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